User Network Guide
Contents

USER NETWORKING MANAGEMENT ................................................................. 1

User Networking: Process Overview ............................................................... 1
  User Networking Accounts ........................................................................... 2
  User Networking Member .......................................................................... 3
  User Networking Administrator .................................................................. 3
  User Networking Group Owner ................................................................... 3
  User Networking Group Administrator ....................................................... 3

Manage User Networking Site ....................................................................... 3

User Networking Parts .................................................................................. 5
  User Networking Manager ......................................................................... 5
  Add Custom Tab ......................................................................................... 6
  Accounts/Friends Tab ................................................................................. 9
  Home Tab ................................................................................................ 12
  Messaging Tab .......................................................................................... 14
  Groups Tab ................................................................................................ 15
  Photos Tab ................................................................................................ 18
  Preferences Tab ........................................................................................ 19
  Administration Tab .................................................................................... 20
  Notifications Tab ....................................................................................... 22
  Captions Tab ............................................................................................. 24
  Styling Tab ................................................................................................ 25

User Link Module .......................................................................................... 27

My Friends .................................................................................................... 28
User Networking Management

User Networking: Process Overview

A user networking site within your online community helps drive users to your website and allows them to promote awareness for your organization and its mission. With a user networking site, your website users can generate online relationships and send messages to one another. You can also allow users to create groups with like-minded users and upload photos into albums.

User networking includes multiple parts that, together, complete your interactive online community. The main part, the User Networking Manager, is contained within your website.

User Networking: Process Overview

To develop a complete user networking experience requires several steps in different areas of the program.

Step 1
Designate roles to access the user networking administrator account on your user networking site. For information, see User Networking Accounts on page 2.

Step 2
Plan the user networking site and inform everyone involved about your plans.

Step 3
In Parts, the website designer creates the Profile Display parts to appear as the profile pages for user networking members and groups. For example, to display a website user’s profile image, unread messages, and ranking, the website designer can use merge fields to design the Profile Display part for a member’s profile page.

Step 4
If your user networking site includes a home page, in Parts, the website designer must create the part to appear as the home page. You can use any part type as the home page.

Step 5
In Parts, the website designer creates the User Networking Manager part and other parts needed for the user networking site. For example, to allow user networking members to perform user networking tasks from multiple
pages on your website, the website designer must create a User Link Module part. For information about the parts required for a user networking site, see User Networking Parts on page 5.

**Step 6**

In *Parts*, the website designer creates the path website users use to access the web page that contains the User Networking Manager part. For example, the website designer can create a link to the web page from the Home page or menu, or the website designer can designate that the page appear immediately after a user networking member logs in to your website.

**Step 7**

In *Notifications*, the website designer creates the email notifications needed for the User Networking Manager part. For example, user networking members can receive notifications when they receive a personal message or friend request from another member.

**Step 8**

In *Pages & templates*, the website designer creates and publishes the web pages and templates that contain the user networking parts.

**Step 9**

Users visit the user networking site and sign up to become active members. User networking members can interact with other user networking members and manage their profile information. For information about the user networking experience, see Manage User Networking Site on page 3.

**Step 10**

Each time a user networking member updates the email forwarding address on the profile page, the program generates a profile update transaction. You can also select to generate a profile update transaction each time a member creates a user networking group. In your offline database, users download these transactions to update constituent records linked to your user networking members.

**User Networking Accounts**

Multiple types of accounts exist for users of a User Networking Manager part: User Networking Member, User Networking Administrator, User Networking Group Owner, and User Networking Group Administrator. User networking administrators are based on roles you select in *Roles*. Users with Supervisor rights can automatically access the Administrator account on your user networking site. When you design the User Networking Manager part, you can assign additional roles to the Administrator account. Users do not sign up to be user networking administrators; users can only access the Administrator account based on their roles in *Roles*.

When you design the User Networking Manager part, you select the users who can sign up to become user networking members and user networking group owners. For example, you can select to allow only users who are linked to constituents in your offline database to create Member accounts on the User Networking Manager part.
User Networking Member

User networking members are the general users of the User Networking Manager part on your website, such as those who sign up for a user networking account through the part. When the User Networking Manager part is created, the website designer selects whether all website users or only those who are linked to constituent records in your offline database can sign up for user networking accounts.

User Networking Administrator

The User Networking Manager part requires at least one user networking administrator. By default, users with Supervisor rights can automatically access the Administrator account on the User Networking Manager part. When the User Networking Manager part is created, the website designer can select additional roles to access the Administrator account. User networking administrators can interact with user networking members on behalf of your organization, such as to lock, unlock, delete, or remove accounts. Administrators can also manage a member’s account, such as to clear messages or contact lists, return a profile image to the default, or adjust a friendly URL.

Note: A user networking administrator can clear the group relations of user networking members. However, if a member is the owner of a user networking group, the administrator cannot clear the relationship between the member and the group. For information about group owners, see User Networking Group Owner on page 3.

User Networking Group Owner

When the User Networking Manager part is created, the website designer selects whether all user networking members can create user networking groups or only users with Supervisor rights. When a user networking member creates a user networking group through the User Networking Manager part, the user automatically becomes the user networking group owner. The user networking group owner can select how the group appears on the user networking site and invite members to join the group. The user networking group owner can also share the ownership and management of the group with other members. For information about user networking members who share the responsibilities with a user networking group owner, see User Networking Group Administrator on page 3.

User Networking Group Administrator

When a user networking group owner promotes a member of the user networking group, the member automatically becomes a user networking group administrator. The user networking group administrator can perform the same tasks as the group owner to manage the user networking group. For information about the tasks of a user networking group owner, see User Networking Group Owner on page 3.

Note: When the User Networking Manager part is created, the website designer can create an attribute to assign to user networking members who create user networking groups. The program does not generate a profile update transaction when a user networking group owner promotes user networking members to act as user networking group administrators. In your offline database, the attribute appears only for the constituent who creates the user networking group.

Manage User Networking Site

When you add a User Networking Manager part to a page on your website, user networking members can use your user networking site to create accounts and manage their profile information. The user networking site provides a central location for user networking members to manage their online relationships and send messages to one another. To allow members to navigate between user networking tasks, a user networking
account contains multiple tabs. The tabs that appear on the user networking site depend on the features you enable on the User Networking Manager part. In addition, you can add custom tabs to the User Networking Manager part to display additional information to user networking members. For example, to display images on the user networking site, you can create a tab and add a Slideshow part.

Note: When you design the User Networking Manager part, you can adjust the display names of the fields and tabs that appear on your user networking site. This section uses the default captions generated by the User Networking Manager part. For information about how to change the captions, see User Networking Manager on page 5.

- **Home** — If you select Enable Home on the User Networking Manager part, the Home tab appears. By default, the Home tab appears first when members log in to your user networking site. When you design the User Networking Manager part, you can select a part to appear on the Home tab. For example, you can create and select a Profile Display part that welcomes the member to the site and includes targeted links and user networking information specific to the member.

Note: By default, if you do not select Enable Home, the Messages tab appears first when members log in to the user networking site.

- **Messages** — The Messages tab contains the member’s inbox. From this tab, members can compose and send messages to and receive messages from other user networking members in their contact lists. Members can also organize and delete messages in the inbox. When you design the User Networking Manager part, you specify how many messages appear on a page of the inbox and whether the program automatically refreshes the inbox.

Note: When a user blocks another member, the program does not deliver messages or friend requests sent to the user by the blocked member. When a user removes a member from the Friends list, the removed member can continue to view the user’s profile, and the user can continue to receive friend requests from the removed member.

- **Friends** — The Friends tab contains the list of the member’s friends on the user networking site. From this tab, the member can search for other members, send friend requests, and approve or deny friend requests from other members. Group owners and group administrators on your user networking site can send invitations to the group from the Friends tab. When you design the User Networking Manager part, you specify how many friends appear on a page of the contact list and whether you rank members based on the number of friends in contact lists.

Note: When a group owner promotes a member of the group, the promoted member becomes a user networking group administrator. For information about user networking group administrators, see User Networking Group Administrator on page 3.

- **Groups** — If you select Enable Groups on the User Networking Manager part, the Groups tab appears. The Groups tab contains the list of the member’s user networking groups. From this tab, the member can search for user networking groups and approve or deny invitations received. From this tab, group owners and group administrators can also manage their groups, such as to promote, demote, or remove existing members. When you design the User Networking Manager part, you specify how many groups appear on a page of the list and how groups appear by default on your site. You can also select the users who can create groups and the attribute to assign to constituents who create groups.

Note: When you design the User Networking Manager part, you can add custom tabs to display additional information to user networking members. For example, to display images on the user networking site, you can create a tab and add a Slideshow part.

- **Photos** — If you select Enable Photos on the User Networking Manager part, the Photos tab appears. The Photos tab contains albums with a member’s uploaded photos. From this tab, the member can upload multiple photos and organize them into albums. The member can also use these uploaded photos to edit the profile image.

The member selects security settings for each album to determine who can view the photos in the albums. The member can make the photos viewable by everyone, friends only, or the member only (private). Album
security applies to all areas on the website where the photos appear, including slideshows, personal pages, and profile displays.

- **Preferences** — If you select Enable Preferences on the User Networking Manager part, the Preferences part appears. On this tab, members can adjust user networking information, such as the display name, email forwarding address, or online status. A member can also create a friendly URL to the profile page. When you design the User Networking Manager part, you select whether to generate a profile update transaction when a member edits email forwarding address.

- **Administration** — By default, all users with Supervisor rights can access the Administrator account to act as administrators on your user networking site. When you design the User Networking Manager part, you can specify other roles in Roles to access the Administrator account to act as user networking administrators. If you select Enable Administration, the Administration tab appears for users in roles that can access the Administrator account. From this tab, user networking administrators can manage interactions on your site. For more information about the user networking administrator, see User Networking Administrator on page 3.

- **My Page** — The My Page tab provides a link to the user networking member’s profile page. When you design the User Networking Manager part, you select the profile page. The page must include a Profile Display part. On the Profile Display part, you can add merge fields to display information specific to the member, such as the profile image, unread messages count, and ranking. To access the profile page, user networking members select the My Page tab.

  **Tip:** For an enhanced user networking experience, you can include additional parts on the profile page. With a User Link Module part, members can perform multiple user networking actions, such as approve a friend and block a user, from profile pages. Similarly, with a My Friends part, users who visit a member’s profile page can quickly view friends and groups associated with the member, as well as any mutual friends or groups. For information about these parts, see User Networking Parts on page 5.

### User Networking Parts

The user networking site includes multiple parts that, together, complete an interactive online community. The main part, the User Networking Manager, is contained within your website. The User Networking Manager part enables user networking members to create online relationships and share messages and photos with one another. With the User Link Module part, user networking members can perform user networking actions, such as approve a friend and block a user, from multiple pages on your website.

For an enhanced user networking experience, create a My Friends part. With the My Friends part, you design how lists of online relationships appear for your user networking members.

### User Networking Manager

With the User Networking Manager part, you can create and design a socially interactive site that drives users to your organization’s website to manage online relationships. When you design the User Networking Manager part, you can configure the user networking accounts so that website users can send messages, make friends or groups with like-minded users, and upload photos to online accounts.

**Note:** You can only create one User Networking Manager part. In Sites & settings, you can copy a site with the User Networking Manager part and share the part between sites, but you cannot create additional User Networking Manager parts for additional sites.

- **Design User Networking Manager**

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see the Parts
Guide.

1. On the Design tab, complete the tabs of the User Networking Manager part.
   - To add a custom tab to the User Networking Manager part, click Add New Tab. You can use the custom tab to display additional information on your user networking site. For information about how to create a tab, see Add Custom Tab on page 6.
   - To select the website users who can sign up for user networking and design how member accounts and friends contact lists appear on your user networking website, select the Accounts/Friends tab. For information about this tab, see Accounts/Friends Tab on page 9.
   - To select a part to appear as the home page of your user networking site, select the Home tab. For information about this tab, see Home Tab on page 12.

   Note: If you do not enable a home page or select a part to appear on the home page, the Messaging inbox of the member’s profile appears first when the member logs into the user networking site. For information about how to set up the inbox, see Messaging Tab on page 14.

   - To design the inbox where user networking members send and receive messages with other members or groups, select the Messaging tab. For information about this tab, see Messaging Tab on page 14.
   - To allow website users to create groups of user networking members, such as those united under a similar cause, select the Groups tab. For information about this tab, see Groups Tab on page 15.
   - To allow members to upload photos to accounts on your user networking site, select the Photos tab. For information about this tab, see Photos Tab on page 18.
   - To allow website users to adjust their user networking member information, such as an online display name or email forwarding address, select the Preferences tab. For information about this tab, see Preferences Tab on page 19.
   - To design how user networking administrator accounts and deleted accounts appear on your user networking website and assign roles in Roles to act as user networking administrators, select the Administration tab. For information about this tab, see Administration Tab on page 20.
   - To view and adjust the notification types associated with the User Networking Manager part, select the Notifications tab. For information about this tab, see Notifications Tab on page 22.
   - To customize a field name or caption on your user networking site to better suit the needs of your organization, select the Captions tab. For information about this tab, see Captions Tab on page 24.
   - To adjust the Cascading Style Sheets (CSS) of your user networking website, select the Styling tab. For information about this tab, see Styling Tab on page 25.

2. Click Save. You return to Parts.

   Warning: After you select the tabs to include on your user networking site, we recommend that you preview your site. If your tabs do not fit in a single row, the appearance of your user networking site may deteriorate. The number of tabs that can fit in a row depends on the design of your website and the length of the labels on the tabs.

Add Custom Tab

The web page with the User Networking Manager part acts as a central location for user networking members to manage their online relationships and send messages to one another. To display additional information to user networking members, you can add custom tabs to the user networking site. On each custom tab, you can select
a part to display. For example, to display images on the user networking site, you can create a tab and add a Slideshow part.

**Note:** Not all parts are available for custom tabs. The parts that are available include: Change User ID/Password, Email Forwarding Form, Flash Player, Formatted Text and Images, Formatted Text and Images (Secured), Personal Notes, Personal Page Manager, Poll, Profile Form, Slideshow, Transaction Manager, User Email Preferences Form, User Interests Form, and User Photos Form.

- **Add custom tab**
  1. On the User Networking Manager part, click **Add New Tab** to create a custom tab.
  2. The Edit Tab screen appears. In the **Tab Name** field, enter a label for the tab.
  3. To select a part, click **Select Part**. The Select a Part screen appears.
  4. Select a part and click **Select**.
  5. On the Edit Tab screen, click **OK**. You return to the Edit Part screen. The new tab appears at the end of the list of standard tabs for the User Networking Manager.
6. Under **Tab Properties**, you can delete the tab, edit its label, and edit the part.
   - To delete the tab, click **Remove Tab**.
   - To change the label, edit it in the **Tab Name** field and click **Change**.
   - To edit the part, click **Edit this part** in the **Part** field.

7. To save the User Networking Manager part, click **Save**. You return to **Parts**.

**Note:** After you add tabs to your user networking site, we recommend that you preview your site. If your tabs do not fit in a single row, the appearance of your user networking site may deteriorate. The number of tabs that can fit in a row depends upon the design of your website and the length of the labels on the tabs.

To design another piece of the User Networking Manager part, select the applicable tab.

- Accounts/Friends Tab on page 9
- Home Tab on page 12
- Messaging Tab on page 14
- Groups Tab on page 15
- Photos Tab on page 18
- Preferences Tab on page 19
- Administration Tab on page 20
- Notifications Tab on page 22
- Captions Tab on page 24
- Styling Tab on page 25
Accounts/Friends Tab

With a User Networking Manager part, you can select the website users who can create user networking accounts and the web pages that appear for user networking members. You can require website users to accept a disclaimer before they create a user networking account. On the Accounts/Friends tab, you must design how users with member accounts appear on your website.

If you allow user networking members to create and maintain online relationships through your site, members can request to be added as friends to other members’ contact lists. A member who receives friend requests can select to approve or deny online relationships with each member who sends a friend request. Members manage their online relationships through a contact list on the user networking site, such as to search for a specific member or block interaction with another member. With a User Networking Manager part, members can send and receive messages with members who appear as friends in their contact lists. On the Accounts/Friends tab, you can design the friends contact list for user networking members.

On the Accounts/Friends tab, you can also create a ranking system based on the amount of friends users have in their contact lists. A ranking system helps encourage user networking members to create and maintain online relationships on your website. When you create a ranking system, you select the ranks users can achieve and set the limits for each rank.

- Design member accounts
  1. On the User Networking Manager part, select the Accounts/Friends tab.
  2. To allow user networking members to maintain contact lists of their online relationships through your website, design how the contact list and members in a contact list appear on your website.
     a. Select Enable Friends.
     b. On the website, user networking members select a tab on their accounts to view friends contact lists. In the Display Name field, enter the name to appear on this tab. Use the default name “Friends” or enter a name more specific to your organization.

     ![Accounts/Friends Tab](image)

     c. In the Friends per page field, enter the number of friends to appear on a member’s friends contact list. If the list contains more friends than the amount you enter here, the contact list contains multiple pages so the user networking member can access all friends. By default, the contact list displays ten friends on a page.
     d. In the Profile Page field, select the page to appear as the profile page for members. The page selected must include a Profile Display part.
To not provide a profile page for your user networking members, select “<Do not use a profile page>.” If you do not provide a profile page for your members, the My Page tab does not appear on your user networking site.

**Note:** The page you select in the Profile Page field provides all the information that appears on members’ profile pages. User networking members cannot generate content on their profile pages. On the Profile Display part, you can add merge fields to display information specific to a user networking member, such as the member’s profile image, unread messages, and ranking. For more information about the Profile Display part, see the Parts Guide.

3. Under Account Security Access, select the website users who can create user networking accounts.
   - To allow all website users to sign up for user networking accounts, regardless of whether they are linked to constituent records in your offline database, select All Blackbaud Internet Solutions Users.
   - To allow only website users who are linked to constituent records in your offline database to sign up for user networking accounts, select Linked Blackbaud Internet Solutions Users.

4. Under Default Account Profile Image, select the default image to appear for members, such as in contact lists and on profile pages. To select an image, click Select image and use the Select Image from Image Library screen.

   For information about how to insert an image from the Image library, see the Program Basics Guide.

   **Note:** If you select Enable Photos and Enable Preferences, a member can upload photos and images into albums in her user networking account and select a photo to appear as her profile image. The image you select under Default Account Profile Image appears when the user first creates the user networking account or if the member does not select a new profile image. For information about the Photos tab, see Photos Tab on page 18.

5. To require that website users review and accept your organization’s terms and conditions before they can create user networking accounts, select Enable Disclaimer.

   In the box, enter the terms to appear. For example, you can require that users agree to post appropriate content and use the user networking site responsibly before they can create accounts.

   - For **Account Not Created**, select the page to appear when the program did not create the account, such as when the user declines the terms entered in the **Enable Disclaimer** box.
   - For **Locked Account**, select the page to appear when a user networking administrator locked the account.
   - For **Deleted Account**, select the page to appear when a user networking administrator deleted the account.
   - For **Not Authorized**, select the page to appear when the member lacks the authorization to view the account.

By default, the program directs members to the home page of the website, as configured in **Sites & settings**. To select a different web page to appear for a specific account status, click **Change**. On the Select a Page screen, select the page to appear and click **Select**. You return to the Accounts/Friends tab.

7. To rank members based on the number of friends in their contact lists, create a ranking system. A ranking system helps encourage user networking members to create and maintain online relationships on your website.

   a. Select **Enable Ranking**.

   b. In the **Display Name** field, enter the field name to appear for the rank on your website, such as in a contact list or on a profile page. Use the default name “Ranking” or enter a name more specific to your organization.

   c. Click **Add New Ranking**. The New Ranking screen appears.

   d. In the **Name** and **Description** fields, enter a name and description to help identify the new rank.
e. In the Minimum and Maximum fields, enter the minimum and maximum number of accepted friends a user must have to receive this rank.

f. Click Save. You return to the Accounts/Friends tab.

8. To save the User Networking Manager part, click Save. You return to Parts.

To design another piece of the User Networking Manager part, select the applicable tab.

- Add Custom Tab on page 6
- Home Tab on page 12
- Messaging Tab on page 14
- Groups Tab on page 15
- Photos Tab on page 18
- Preferences Tab on page 19
- Administration Tab on page 20
- Notifications Tab on page 22
- Captions Tab on page 24
- Styling Tab on page 25

Home Tab

You can select a part to appear as the home page on the user networking site. By default, when website users access their user networking accounts, the home page appears first. On the Home tab, you can select the part to appear as the home page. For example, you can create a Profile Display part with links to personal pages and merge fields that display user networking information such as online status and total of unread messages.

**Note:** If you do not enable and create a home page for the user networking site, by default, the Messaging inbox of the member’s profile appears first when the member logs into the user networking site. For information about how to set up the inbox, see Messaging Tab on page 14.

Design home page

1. On the User Networking Manager part, select the Home tab.
2. Select **Enable Home**.

3. On the website, user networking members can select a tab on their accounts to view the home page. In the **Display Name** field, enter the name to appear on this tab. Use the default name “Home” or enter a name more specific to your organization.

4. Select the part to appear as the home page.
   a. Click **Select Part to Display**. The Select a Part screen appears.
   b. Select the option next to the part to appear as the home page.
   c. Click **Select**. You return to the Home tab.

5. To save the User Networking Manager part, click **Save**. You return to **Parts**.

To continue to design the User Networking Manager part, select the applicable tab.

- Add Custom Tab on page 6
- Accounts/Friends Tab on page 9
- Messaging Tab on page 14
- Groups Tab on page 15
- Photos Tab on page 18
- Preferences Tab on page 19
- Administration Tab on page 20
- Notifications Tab on page 22
- Captions Tab on page 24
- Styling Tab on page 25
Messaging Tab

If you enable messaging on your user networking site, members can send and receive messages with friends and groups in their contact lists. A member manages these messages through an inbox on your website. From the inbox, the member can send, receive, and delete messages. Members can also create folders to organize messages. On the Messaging tab, you can design the inbox your members use.

- Design messages inbox
  1. On the User Networking Manager part, select the Messaging tab.

2. Select Enable Messaging.

3. On the website, user networking members can select a tab on their accounts to view the inbox. In the Display Name field, enter the name to appear for this tab. Use the default name “Messages” or enter a name more specific to your organization.

4. In the Messages per page field, enter the number of messages to appear on the inbox. If the inbox contains more messages than the amount you enter here, the inbox contains multiple pages so the user networking member can access all messages.

5. To have the program automatically check for new messages and refresh the inbox, in the Inbox Auto-Refresh field, select Enabled and enter how often, in seconds, the program refreshes the inbox. By default, when you enable automatic refresh, the program checks for messages every 30 seconds.

   **Warning:** We recommend you set the automatic inbox refresh at an interval of 30 seconds. If you set the automatic inbox refresh to a more frequent interval, we recommend you set it to no less than 10 seconds. Depending on your website environment and configuration, an interval more frequent than every 10 seconds can result in performance issues.

6. In the Message Format field, select the format to generate messages in.
   - To generate messages in an HTML format, select HTML. This format supports text formatting, pictures, and links to other websites. However, not all email programs support this format.
To generate messages in a plain text format, select Text. All email programs support the plain text format. However, this format does not support text formatting or display pictures in the body text.

7. To enable users to reply to messages received from a user networking administrator, select **Allow users to Reply to Administration Messages**.

*Note:* On the Administration tab, you select the email list to receive messages sent from a user networking member to a user networking administrator. When you select **Allow users to Reply to Administration Messages**, the program sends reply messages from members to the selected email lists. For information about how to set up an Administrator account on your user networking site, see **Administration Tab** on page 20.

8. To enable users to forward messages received from a user networking administrator to other members, select **Allow users to Forward Administration Messages**.

9. To save the User Networking Manager part, click **Save**. You return to **Parts**.

To continue to design the User Networking Manager part, select the applicable tab.

- Add Custom Tab on page 6
- Accounts/Friends Tab on page 9
- Home Tab on page 12
- Groups Tab on page 15
- Photos Tab on page 18
- Preferences Tab on page 19
- Administration Tab on page 20
- Notifications Tab on page 22
- Captions Tab on page 24
- Styling Tab on page 25

**Groups Tab**

On the Groups tab, you can allow website users to create groups of user networking members, such as those united under a similar cause or with similar interests. The program automatically assigns the member who creates the group the role of Group Owner. The Group Owner manages the group, such as to invite other members to join the group or remove members from the group. Members who receive group invitations can select to join the groups. A member manages her groups through a contact list on your website. From the contact list, a member can search for a group and send messages to group owners who appear in the contact list. To enable website users to create and manage user networking groups, you must complete the options on the Groups tab.

- **Design member groups**
  1. On the User Networking Manager part, select the Groups tab.
2. Select Enable Groups.

3. On your website, user networking members select a tab on their accounts to view groups contact lists. In the Display Name field, enter the name to appear for this tab. Use the default name “Groups” or enter a name more specific to your organization.

4. In the Groups per page field, enter the number of groups to appear on a groups contact list. If the list contains more groups than the amount you enter here, the contact list contains multiple pages so the user networking member can access all groups.

5. Under Profile Page, select the page to appear as the profile pages for your groups. The page selected must include a Profile Display part.

   **Note:** The page and Profile Display part you select in the Profile Page field provides the information that appears on the group profile pages. The group’s owner or members cannot generate content on the profile page. On the Profile Display part included on the page, you can add merge fields to display information specific to a user networking group, such as the group’s profile image and member count. For more information about the Profile Display part, see the Parts Guide.

6. Under Default Group Profile Image, select the default image to appear for groups, such as in contact lists and on profile pages. To select an image, click Select image and use the Select Image from Image Library screen.

   For information about how to insert an image from the Image library, see the Program Basics Guide.

   **Note:** If you select Enable Photos and Enable Preferences, a group owner can upload photos and images into albums in her user networking account and select a photo to appear as the profile image for the group. The image you select under Default Account Profile Image appears when the member first creates the group or if the group owner does not select a new profile image. For information about the Photos tab, see Photos Tab on page 18.

7. Under Create New Group Security Access, select the user networking members who can create groups.
To allow all members to create user networking groups, select **All Users**.

To allow only user networking administrators to create user networking groups, select **Site Administrators Only**.

8. To require that website users review and accept your organization’s terms and conditions before they can create groups, select **Enable Disclaimer**.

In the box, enter the terms to appear. For example, you can require that users agree to ensure the group’s mission is appropriate and to manage the group responsibly before they can create a group.

9. Under **New Group Attribute**, select the attribute to assign to constituents who create new groups on your website. When constituents create groups, the program automatically updates the profile with this attribute. To update the constituent record in your offline database, you can download the profile update transaction.

10. To save the User Networking Manager part, click **Save**. You return to **Parts**.

To continue to design the User Networking Manager part, select the applicable tab.

- Add Custom Tab on page 6
- Accounts/Friends Tab on page 9
- Home Tab on page 12
- Messaging Tab on page 14
- Photos Tab on page 18
- Preferences Tab on page 19
- Administration Tab on page 20
- Notifications Tab on page 22
- Captions Tab on page 24
Photos Tab

To allow users to upload photos and manage albums on your user networking site, you must complete the options on the Photos tab of the User Networking Manager part.

- Design member photos page

  1. On the User Networking Manager part, select the Photos tab.

      ![Configure the options for this User Networking Manager.](image)

  2. Select Enable Photos.

      \textit{Note:} When you select Enable Photos, security options appear when a member creates an album. The member can make the photos viewable by everyone, by friends only, or by himself only (private). Album security applies to all areas where the photos are used in the website, including slideshows, personal pages, and profile displays.

  3. On your website, user networking members select a tab on their accounts to view and manage photo albums. In the \textit{Display Name} field, enter the name to appear for this tab. Use the default name “Photos” or enter a name more specific to your organization.

  4. To save the User Networking Manager part, click Save. You return to \textit{Parts}.

To continue to design the User Networking Manager part, select the applicable tab.
- Add Custom Tab on page 6
- Accounts/Friends Tab on page 9
- Home Tab on page 12
- Messaging Tab on page 14
- Groups Tab on page 15
- Preferences Tab on page 19
- Administration Tab on page 20
Preferences Tab

You can allow website users to adjust their user networking member information, such as an online display name or email forwarding address. A website user can also generate a friendly URL, or shortened web address, to his user networking profile page on your website. To enable website users to manage their user networking member information, you must configure member preferences on the Preferences tab of the User Networking Manager part. You can also select to automatically generate a profile update transaction when a website user adjusts a user networking preference.

- Design member preferences page
  1. On the User Networking Manager tab, select the Preferences tab.

    ![User Networking Manager Preferences Tab]

    Select Enable Preferences.

  2. Select Enable Preferences.

  3. On your website, members select a tab on their accounts to view and adjust their user networking information. In the Display Name field, enter the name to appear for this tab. Use the default name “Preferences” or enter a name more specific to your organization.

  4. Under Transactions, select whether to automatically generate profile update transactions when a website user adjusts the email forwarding address on the preferences page.

     If you select Update Email Address, you can download profile update transaction information to constituent records in your offline database.

     **Note:** The program does not generate a profile update transaction when a user with Supervisor rights updates the email forwarding address on the preferences page.

  5. To save the User Networking Manager part, click Save. You return to Parts.

     To continue to design the User Networking Manager part, select the applicable tab.
Add Custom Tab on page 6
Accounts/Friends Tab on page 9
Home Tab on page 12
Messaging Tab on page 14
Groups Tab on page 15
Photos Tab on page 18
Administration Tab on page 20
Notifications Tab on page 22
Captions Tab on page 24
Styling Tab on page 25

**Administration Tab**

By default, users with Supervisor rights automatically have full access to user networking members. In addition, you can allow users in other roles to act as user networking administrators, who interact with members on behalf of your organization. From the Administration tab of the user networking site, user networking administrators can manage interactions with your user networking members. For example, a user networking administrator can lock or remove accounts, clear a member’s messages, return a member’s profile image to the default image, or adjust a friendly URL. On the Administration tab, you must assign roles in *Roles* to act as user networking administrators and design how those users appear when they interact with member on behalf of your organization. You can also design how accounts the user networking administrators delete appear on your website.

- **Design administrator account**
  1. On the User Networking Manager part, select the Administration tab.
  2. Select **Enable Administration**.
  3. On your website, user networking administrators select a tab to manage their interactions with your members. In the **Display Name** field, enter the name to appear for this tab. Use the default name “Administration” or enter a name more specific to your organization.
4. Under **Administrator Account**, configure how members appear on the website when they interact with user networking members on behalf of your organization as user networking administrators.

   a. In the **Display Name** field, enter the name to appear when a user networking administrator interacts with your members. Use the default name “Administrator” or enter a name more specific to your organization.

   b. In the **Email Lists** field, select the email list of recipients to receive messages sent to a user networking administrator, such as if a member sends a message to report inappropriate content posted to your site.

      To select an email list, click **Change**. On the Select Email Lists for the Administrator Account screen, add the user-defined email list to receive email messages intended for a user networking administrator to the **Selected List** frame and click **OK**. You return to the Administration tab.

      **Note:** To select a user-defined email list for a user networking administrator account, you must first create and store it in **Lists**. For more information about **Lists**, see the **Email Guide**.

   c. In the **Profile Image** field, enter the image to appear for a user networking administrator, such as in a contact list or an inbox. To select an image, click **Select image** and use the Select Image from Image Library screen.

      For information about how to insert an image from the Image library, see the **Program Basics Guide**.

5. Under **Administration Privileges**, select the roles whose members can act as user networking administrators.

   a. Click **Change**. The Select Roles screen appears.

   b. In the grid, select the roles to act as administrators on your user networking site.

   c. Click **OK**. You return to the Administration tab.
6. Under **Deleted Account**, configure how member accounts appear on your user networking site, such as in saved messages and contact lists, after a user networking administrator deletes them.
   a. In the **Display Name** field, enter the name to appear for a deleted account. Use the default name “Deleted Account” or enter a name more specific to your organization.
   b. In the **Profile Image** field, enter the image to appear for a deleted account, such as in a contact list or an inbox. To select an image, click **Select image** and use the Select Image from Image Library screen.

   For information about how to insert an image from the *Image library*, see the *Program Basics Guide*.

7. To save the User Networking Manager part, click **Save**. You return to *Parts*.

To continue to design the User Networking Manager part, select the applicable tab.

- **Add Custom Tab** on page 6
- **Accounts/Friends Tab** on page 9
- **Home Tab** on page 12
- **Messaging Tab** on page 14
- **Groups Tab** on page 15
- **Photos Tab** on page 18
- **Preferences Tab** on page 19
- **Notifications Tab** on page 22
- **Captions Tab** on page 24
- **Styling Tab** on page 25

**Notifications Tab**

In *Notifications*, you can create notification types to alert user networking members when they receive new personal messages, friend requests, or group invitations through your website. When you create a user networking notification type, you associate it with a User Networking Manager part. On the Notifications tab of the User Networking Manager part, you can view and adjust its associated notification types.

For more information about notification types, see the *Email Guide*.

- **View a user networking notification**
  1. On the User Networking Manager part, select the Notifications tab. The grid displays the user networking notifications in your database. In the grid, the **Active for this Part** column indicates whether the user networking manager uses a notification.
2. To add a notification for the part, click **Create New Notification**. The Select Notification Type screen appears so you can select the type of notification to create.

**Warning:** To create notifications for a User Networking Manager part in Mozilla Firefox, you must first disable the pop-up window block. In Firefox, select **Tools, Options** from the menu bar. On the Options screen, select the Content tab and click **Exceptions** next to the **Block pop-up windows** checkbox. On the Allowed Sites screen, enter the addresses of the websites to allow pop-up windows and click **Close**. To return to the Edit Part screen, click **OK**.

3. To edit a notification, such as to apply it to the workflow, click **Edit** in the **Action** column. The notification appears. Under **Specify parts using this workflow**, you can select the parts that use the notification. To return to the Edit Part screen, click **Save**.

   For information about how to add or edit a notification type, see the **Email Guide**.

4. To save the User Networking Manager part, click **Save**. You return to **Parts**.

To continue to design the User Networking Manager part, select the applicable tab.

- Add Custom Tab on page 6
- Accounts/Friends Tab on page 9
- Home Tab on page 12
- Messaging Tab on page 14
- Groups Tab on page 15
- Photos Tab on page 18
- Preferences Tab on page 19
- Administration Tab on page 20
- Captions Tab on page 24
- Styling Tab on page 25
Captions Tab

On the Captions tab, you can customize all the field names and captions that appear on the user networking site. For example, you can change Disclaimer to read “Terms and Conditions.”

- Design user networking captions
  1. On the User Networking captions part, select the Captions tab.

    ![Captions Tab Image]

    2. In the Default Caption column, find the field name or caption to change.
    3. In the Display Caption column, enter the text to appear on the website for the field or caption.
    4. To save the User Networking Manager part, click Save. You return to Parts.

To continue to design the User Networking Manager part, select the applicable tab.
  - Add Custom Tab on page 6
Styling Tab

The User Networking Manager part uses Cascading Style Sheets (CSS) to manage the appearance of your user networking site. CSS controls the format and layout of the site, such as the color of links, font size and types, and the spacing of tables. When you design a User Networking Manager part, you can use the Styling tab to customize the default CSS class properties of the part.

Note: The User Networking Manager part contains a large number of CSS classes. To save time and minimize rework, you manage its classes on the Styling tab rather than in Style sheets like other parts. With the Styling tab, you can adjust all the CSS classes of the User Networking Manager part in one step.

Design a style sheet for the user networking site

1. On the User Networking Manager part, select the Styling tab. Under Cascading Style Sheets (CSS) Editor, the CSS for the user networking site appears.
2. Edit the elements of the CSS as necessary.

**Warning**: When you design and customize the user networking site, we recommend you test its rendering in multiple browsers. For example, if your primary browser is *Internet Explorer*, we recommend you also test your site with Mozilla *Firefox*. If your user networking site the renders differently, we recommend you modify style sheets so the site has a similar look and feel in all browsers you test.

To return the CSS elements to the default style sheet, click **Click here**.

3. To save the User Networking Manager part, click **Save**. You return to *Parts*.

To continue to design the User Networking Manager part, select the applicable tab.

- Add Custom Tab on page 6
- Accounts/Friends Tab on page 9
- Home Tab on page 12
- Messaging Tab on page 14
- Groups Tab on page 15
• Photos Tab on page 18
• Preferences Tab on page 19
• Administration Tab on page 20
• Notifications Tab on page 22
• Captions Tab on page 24

User Link Module

With the User Link Module part, you can display user networking tasks on personal pages and profile displays. This allows you to expand the reach of your user networking site and allows members to create relationships with other website users, creating an active online community.

To include user networking tasks on a personal page, place the User Link Module part on the page with the Personal Page Elements. When user networking members create personal pages, the User Link Module part displays a list of user networking tasks on their pages. These tasks allow other website users who visit the pages to send messages to the page owners, add them as friends, and perform other user networking tasks.

To include user networking tasks on a profile display, place the User Link Module part on the page with a Profile Display part that links to a Directory part. When a website user selects a user profile from your directory, the User Link Module part displays a list of user networking tasks if the profile subject is a user networking members.

The User Link Module part displays the list of user networking tasks to all website users. However, the tasks that appear depend on the user’s role on the user networking site. The User Link Module part only displays tasks that the user has the authority to perform. For example, if a personal page includes the User Link module part and a user networking member visits the page, the list includes only tasks for members. However, if a user networking group owner visits the same page, the list includes tasks for members and for group owners. For website users who are not user networking members, the list includes the tasks for members, but when users click tasks, they are prompted to join the user networking site. For anonymous users, the list also includes the tasks for members, but when users click tasks, they are redirected to a login page. If they are not already user networking members, they are prompted to join the user networking site.

Note: While all website users can view user networking tasks, the User Link Module only displays these tasks if the personal page owner or profile display subject are user networking members. If a website user who is not a user networking member creates a personal page, user networking tasks do not appear on the personal page. The User Link Module allows website users who visit the personal page to interact with page owners through your user networking site. Users cannot interact with page owners who are not user networking members, so the tasks do not appear.

Before you can create a User Link Module part and add it to a page, you must create the User Networking Manager part. For information about the User Networking Manager part, see User Networking Manager on page 5.

- Design User Link Module

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see the Parts Guide.

1. From the Design tab, in the User Networking manager field, select the web page that contains the User Networking Manager part.
2. In the Orientation field, select whether to display the links vertically or horizontally.

3. Under Link options, select the user networking tasks to include on the User Link Module part. The tasks link website users to various sections of the user networking site.

   ![User networking manager](image)

   ![Orientation](image)

   ![Link options](image)

   **Note:** Only include tasks that you want website users to perform from personal pages or profile displays that include the User Link Module part. When you select a task, website users can access the task from those pages. However, tasks only appear if the website users have rights to perform the tasks on the user networking site.

4. Click Save. You return to Parts.

**My Friends**

Create a My Friends part to allow website users who visit a personal page or profile display page to view the online relationships of the member or group associated with the page. For example, you can design My Friends parts for a profile display page to display the friends and groups of a user network member. When a website user visits that member’s profile page, **Friends** and **Groups** panels appear to display the profile images of the member’s online relationships. You can also design My Friends parts to display the friends and groups shared between the user who visits the page and the user associated with the page.

   **Note:** On your website, the My Friends part appears only if it has information to display. For example, if you create a My Friends part to show the friends two users have in common and the user who visits the page and the user associated with the page have no mutual friends, the “Mutual Friends” panel does not appear. Similarly, when a user visits her own Profile Display page, the “Mutual Friends” panel does not appear.

When you create a My Friends part for a page, you design how many columns and profile images appear in the part. Before you create a My Friends part, you must first create its User Networking Manager part. For information about the User Networking Manager part, see User Networking Manager on page 5.

- **Design My Friends**

  For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see the **Parts**
Guide.

1. From the Design tab, in the User Networking manager field, select the web page that contains the User Networking Manager part.

For user networking members, the My Friends part displays a panel with profile images on personal page, fundraiser page, or profile display pages. Select a panel type to determine the type of contacts to display, and enter display options for the panel. If a user networking member does not have any contacts that match the panel type, the panel does not appear.

<table>
<thead>
<tr>
<th><strong>User networking manager:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="User networking manager field" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Panel type:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Panel type dropdown" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Panel label:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Panel label field" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Number of columns:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Number of columns field" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Max records to show:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Max records to show field" /></td>
</tr>
</tbody>
</table>

2. In the Panel type field, select the type of contacts to display The panel displays profile images for the contacts that match your criteria.

- To display user networking friends for the user associated with the page, select “Friends.”
- To display mutual user networking friends for the user who visits the page and the user associated with the page, select “Mutual Friends.”
- To display user networking groups for the user associated with the page, select “Groups.”
- To display mutual user networking groups for the user who visits the page and the user associated with the page, select “Mutual Groups.”

3. In the Panel label field, enter a label for the panel such as “Friends.”

To enter a label for internal use but not display it on the website, select Hide label.

4. In the Number of columns field, enter how many columns to include in the panel. By default, the panel displays profile images in four columns.

5. In the Max records to show field, enter a limit for how many profile images to include in the panel. To display all profile images for applicable contacts, leave the field blank.

**Tip:** We recommend that you limit the number of profile images to include in the panel. If you do not set a limit and the My Friends part displays a large number of profile images, it may compete with the rest of the page for the attention of website users. To allow users to view all friends or groups associated with a member, you can add a Formatted Text and Images part that includes merge fields and a link to a profile display page with a My Friends part with no limit on profile images.

6. Click Save. You return to Parts.